Segment - Installation Manual

April 29, 2019

Software platform v2.2 R7067
MEDVISO AB
http://www.medviso.com
Griffelvägen 3
SE-224 67 Lund
Sweden
Tel: +46-76-183 6442
Contents

1 Conventions and Trademarks ........................................... v
   1.1 Typographic conventions ........................................... v
   1.2 Trademarks ............................................................. v

2 System Requirements ..................................................... vii
   2.1 Operating system .................................................... vii
   2.2 Hardware requirements ............................................. vii
   2.3 Safety Instructions ................................................... vii

3 Installation guide ........................................................... 1
   3.1 Installation of Standalone version for Windows .............. 1
      3.1.1 Installing Matlab Compiler Runtime ....................... 1
      3.1.2 Installing Segment ............................................. 1
      3.1.3 Verify installation of Segment .............................. 3
      3.1.4 Create shortcut ................................................. 3
      3.1.5 Notes for Windows Vista users ............................... 3
      3.1.6 Network installation of Segment ............................ 4
   3.2 Installation for source code version ........................... 4
   3.3 License file ............................................................ 5
   3.4 Upgrading Segment ................................................... 5
   3.5 First time running Segment ......................................... 6
      3.5.1 Setting preferences ............................................. 6
      3.5.2 Setting window positions ..................................... 7
      3.5.3 PACS connectivity ............................................... 7
   3.6 Uninstallation .......................................................... 7
      3.6.1 Uninstalling for Windows ..................................... 8
      3.6.2 Uninstallation for source code ............................... 8
   3.7 Trouble shooting ..................................................... 8
1 Conventions and Trademarks

1.1 Typographic conventions

A  Key A at the keyboard.
Ctrl-A  Control key. Hold down Ctrl key and A simultaneously.
ʼ  Icon in toolbar.
*.mat  Filename extension.
C:/Program  Folder.
File  Menu, e.g. File menu.
File→Save As  Sub menu, e.g. under the File menu the item Save As is found.
Close  Push/Toggle button in the graphical user interface.
□ Endocardium  Radiobutton in the graphical user interface.
☑ Single frame  Checkbox in the graphical user interface.

1.2 Trademarks

Below are some of the trademarks used in this manual.

- Segment is a trademark of Medviso AB.
- Segment DICOM Server is a trademark of Medviso AB.
- Sectra PACS is a trademark of Sectra Imtec AB, (http://www.sectra.se).
- Matlab is a trademark of the Mathworks Inc, (http://www.mathworks.com).
2 System Requirements

In this chapter the hardware requirements for Segment are outlined. Possible bottlenecks are (in order of likelihood) lack of RAM memory, CPU speed, and I/O network or disk transfer rates.

2.1 Operating system

Segment is available both as a stand-alone application and also a source code version. Stand-alone versions are available for the following platforms:

- Microsoft Windows 64-bit platform
- For Mac Segment can be run on virtual machines such as Parallels or using dual booting

The source code version is available for the following platforms:

- Windows 64
- Linux 64

To run the source code format the recommended Matlab version is R2014a.

2.2 Hardware requirements

The list below are the recommended hardware requirements for Segment.

- Computer with 4 GB of memory or preferably 8 GB
- Harddisk with at least 500 MB of available space
- Graphics card supporting both DirectX and OpenGL
- Internet connection for software license management

2.3 Safety Instructions

The computer where Segment is installed should have

- anti-virus protection installed to protect against cyber attacks
CHAPTER 2. SYSTEM REQUIREMENTS

- login to access Segment to ensure that only accredited users use the device
- backup on patient data to ensure no data is lost

In the preferences for Segment the user can activate user login to the device and user logging for the usage of the device.
3 Installation guide

The descriptions for first time installation is divided into two main sections, describing Windows standalone installation (section 3.1) and source code installation (section 3.2), respectively. The sections after that describes general settings that should be performed regardless of installation type.

3.1 Installation of Standalone version for Windows

This section is written for first time installation of Segment. For upgrading, see the Section 3.4. The program is written in Matlab, in order to run it you therefore need to install Matlab Compiler Runtime first. Note that to be able to perform these steps below you need to have administrator privileges on the machine. If you are using Windows Vista, then please also refer to Section 3.1.5.

3.1.1 Installing Matlab Compiler Runtime

If you have Matlab and Matlab Compiler Runtime (MCR) installed on your computer this step may not be necessary, provided that you have exactly the same version as used for compiling Segment. Currently Matlab Compiler Runtime R2014a is required. Download the file MCR_R2014a_win64_installer.exe. Exact name of the file depends on operating system you are installing to. Download the file to a suitable location (i.e your desktop or a temporary folder) and double-click it. Follow the instructions in Figures 1-4.

This step to install MCR Installer does only need to be performed once and should generally not be necessary when upgrading to a later version of the software.

Note: For some operating systems it is required to reboot the computer after installing the MCRInstaller. We therefore, strongly advise all users to reboot the computer after installing the MCRInstaller.

3.1.2 Installing Segment

Download the file (called something like install_Segment_2px_Ryyyy.exe, where 2px is the version number and Ryyyy is the revision number). Place
CHAPTER 3. INSTALLATION GUIDE

Figure 1: Click on Run or Ör.

Figure 2: Click on OK.

Figure 3: Click on Install.
3.1. INSTALLATION OF STANDALONE VERSION FOR WINDOWS

Figure 4: Click on Next.

the file where you easily can find it (i.e. your desktop). When downloaded, double click on the file, and follow the instructions. You will be prompted if you want to install the program to the default location (C:/Program Files or C:/Program depending on operating system language). One advantage of installing to another location, where you have write access, is that you can thereafter install upgrades without being logged in as local administrator.

3.1.3 Verify installation of Segment

To start the program, double click the file C:/Program Files/Segment/Segment.exe, or your shortcut to it. When starting the software, the image in Figure 5 should be displayed. If it is not displayed, then the software is not correctly installed.

3.1.4 Create shortcut

Place a shortcut to the file C:/Program Files/Segment/Segment.exe at your desktop. Note that depending on your system locale, or if you have installed Segment to a non-default location this path may be different. Creating this shortcut is done by using the standard Windows file explorer to find the file, then right click on the file and select the option Create a short-cut. Move the created shortcut to your desktop.

3.1.5 Notes for Windows Vista users

You will need to run the application in administrator mode the first time you run Segment since the first time Segment is started some files are extracted.
CHAPTER 3. INSTALLATION GUIDE

Figure 5: Startup window for Segment.

This operation is blocked in user mode. The second time you run Segment you should be able to run in a user mode.

3.1.6 Network installation of Segment

For advanced users and system administrators, it is possible to make a network installation of Segment. Then you do not need to install MCRInstaller on each machine that is used to run Segment. Make a network installation of MCRInstaller. How to do this shown in this document.


Thereafter place Segment in a network folder, and make sure that each user can find Segment.exe.

3.2 Installation for source code version

Please note that currently is not Linux 32 bit supported, but Linux 64 bit are supported. We will at a later stage also support Linux 32 bit, but it is
3.3. LICENSE FILE

not easy trying to keep all platforms up to date.

Install Segment by:

1. Download .zip file (see download pages)
2. Unzip the file and store contents in directory.
3. Installation complete.

Starting by:

1. Start Matlab
2. Change directory to where you have unpacked Segment.
3. Type segment at Matlab command prompt.

3.3 License file

If you have received a license code (then your version is registered full version), then add your license by enter your license code in the installation process. You can also add your license code after installation by starting Segment and select Generate License under the Help menu in Segment. Please note that these operations may require that you run the software as Administrator (not only beeing logged in as Administrator). This is done by right clicking on the icon of the software and then select ”Run as administrator”. A third way of adding your license is to add a license file (named code.lic) to the same folder as where Segment is installed. If you do not have a license file then the program will run in ’Research only mode’, fully functional where only a few options are disabled. You may then not use the software for commercial research or clinical routine.

3.4 Upgrading Segment

If your previous version used another MCR then you need to first replace your old Matlab Compiler Runtime. To see which version of Matlab Compiler Runtime is required, please see the table below.
CHAPTER 3. INSTALLATION GUIDE

### Segment version

<table>
<thead>
<tr>
<th>Version</th>
<th>MCRInstaller</th>
</tr>
</thead>
<tbody>
<tr>
<td>≤1.675</td>
<td>Matlab Compiler Runtime 7.6</td>
</tr>
<tr>
<td>1.8</td>
<td>Matlab Compiler Runtime 7.8</td>
</tr>
<tr>
<td>1.9</td>
<td>Matlab Compiler Runtime 7.15</td>
</tr>
<tr>
<td>2.0</td>
<td>Matlab Compiler Runtime 2014a</td>
</tr>
<tr>
<td>2.1</td>
<td>Matlab Compiler Runtime 2014a</td>
</tr>
<tr>
<td>2.2</td>
<td>Matlab Compiler Runtime 2014a</td>
</tr>
</tbody>
</table>

If you need to upgrade MCR, follow the installation instructions in Section 3.1. It is **important** to uninstall the old MCR before installing a new one. When having problems installing or uninstalling the MCRInstaller, please consult Mathworks support pages, and search for MCRInstaller.

If you, as in most cases, do not need to upgrade MCR, simply download the Segment installation file and double click on it to install it, as described in Section 3.1.2. If you are running services for the Segment Server solution, then you need to stop and delete them prior to upgrading, please see Patient Database and PACS Communication Manual for details.

### 3.5 First time running Segment

Doubleclick the file \`C:/Program Files/Segment/Segment.exe\`, or your shortcut to it, to start the program. The first time it is started, it runs a setup process which can take a while, so be patient. To complete setup, set preferences and window positions as described in Sections 3.5.1 and 3.5.2.

#### 3.5.1 Setting preferences

It is recommended to set the preferences of which folders to use to avoid browsing each time you want to load or save a file. It is invoked by using the Preferences on the main menu. Set Data, Export and CD folders.

The preferences are saved as a file `.segment_preferences.mat` in a folder that can be accessed by selecting Open Folder with Log Files from the Help menu. This preferences are specific for all users, however it is possible to set default preferences for all users starting to use the software by in the Advanced System and DICOM preferences click on [Save to all]. This preferences file will then be copied to the preferences path of every user that does not
already have preferences saved. It will also override any PACS or Segment Server settings for all users on the machine. Please note that these operations may require that you run the software as Administrator (not only being logged in as Administrator). This is done by right clicking on the icon of the software and then select "Run as administrator".

Further details on how one customizes Segment is given in Customization Chapter in Segment Reference Manual.

3.5.2 Setting window positions

The position of the main window for Segment can be set by dragging the window to an optional position and size. The size and position will be saved so that next time Segment is launched the same position will be used. The window position can also be saved for the file loader, patient database module and PACS connection module, general segmentation module, fusion module, SPECT module and strain module. This feature is under development and eventually it will be possible to set the position for all windows, until then windows will pop up as an overlay in the middle of the window from which it was launched or in the middle of the main Segment window.

In case where one have switched to another monitor Segment may move outside the screen. In this case you could press Shift-Ctrl-R to reset GUI positions. This is also available under the File menu.

3.5.3 PACS connectivity

Setting up PACS connection and Segment Server usually requires help from your local PACS support, and we recommend that contact us to setup a telephone / web-based video conference to make this process as smooth as possible. The Patient Database and PACS Communication manual, and the Sectra PACS plugin manual is found at Medviso AB homepage (http://medviso.com/products/cmr/). The Sectra PACS plugin may require additional Microsoft Visual C++ components that can be downloaded from Medviso AB homepage (http://medviso.com/download2/).

3.6 Uninstallation

Essentially the uninstallation is similar for all versions.
3.6.1 Uninstalling for Windows
There is currently no uninstallation software available. Remove all files in the folder C:/Program/Segment or C:/Program Files/Segment. User preferences are stored in the Application Data and the subfolder Segment under each user account (Windows). To uninstall the Matlab Compiler Runtime, use the Windows functionality Install or Remove Programs in the control panel menu. Please note that if you are running services for the Segment Server solution, then you need to first stop and delete these services before uninstalling the software, as they otherwise will lock files that needs to be deleted. See Patient Database and PACS Communication Manual for details.

3.6.2 Uninstallation for source code
The uninstallation for the source code version is trivial, simply delete all Segment related files.

3.7 Trouble shooting
The absolutely most common problem is the failure to not login as a local administrator of the computer. The second most common mistake is not to read the installation instruction provided in this user manual or on the homepage.

To trouble shoot the installation you can see if the Segment installation program actually was successfully started by checking for the existence of .log files. Segment creates a log file during installation, this file is stored in the user folder (i.e Documents and Settings/Username and Application Data and the subfolder Segment. Note that this folder by default is hidden. If you have problems installing Segment, please send this log-file to support@medviso.com together with a description on what problems where encountered.